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Chapter 1: Introduction

Defining the TechniSat DVB-PC TV Stars

Defining SkyStar 2 PCI/USB

SkyStar 2 PCl is a small board that is plugged into a PCI slot of your computer. The
SkyStar USB is the USB version that is connected to a USB1.1 port of your
computer. It gives you unprecedented access to Internet services and any “Free To
Air” broadcast digital satellite television channel (DVB-S).

Defining AirStar 2 PCI/USB

AirStar 2 PCl is a small board that is plugged into a PCI slot of your computer. The
AirStar USB is the USB version that is connected to a USB1.1 port of your computer.
It gives you unprecedented access to any free to air broadcast digital terrestrial
television channel (DVB-T).

Defining CableStar 2 PCI

CableStar 2 PCl is a small board that is plugged into a PCI slot of your computer. It
gives you unprecedented access to any free available broadcast digital cable
television channel (DVB-C).

Using IP services with a DVB-PC TV Star Device

The TechniSat DVB-PC TV Stars products will request all information by ground-
based Internet. In response the requested data will be delivered using satellite,
broadband cable or terrestrial systems at high speed.

Using printed help

The DVB-PC TV Stars product range includes the 4 parts of the Users Guide (Part 1:
“Installation” / Part 2: “Setup4PC/ServerdPC” / Part 3: “DVBViewer TE” / Part 4:
“Troubleshooting”).

User’s guide conventions

For clarity, the User’s Guide employs the following conventions:

1. Navigation paths are represented as follows:
“Start” => “Programs” => “TechniSat DVB” => “Setup4PC”
The path shown in this example launches Setup4PC

2. Pay attention to the following:

This icon designates a note, which is an important information to the
description above.

This icon designates a warning, which is an important information to the
description above.

3. The DVB-PC TV Stars TV application “DVBViewer TechniSat Edition” is
designated in the following as “DVBViewer TE”
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User Task Summary
Steps to perform basic user tasks are summarized below.

Step one: Watch TV with DVBViewer TE

The second chapter introduces you to the main features of DVBViewer TE. You will
learn how to watch TV and configure DVBViewer TE to your needs.

Step two: Using DVBViewer TE as PVR

After you know how to use the DVBViewer TE as a television, in chapter 3 you will
learn how to use this application as a personal video recorder (PVR) and playback
software for files recorded with the PVR functionality.

Step three: Managing TV/radio channels

In the fourth chapter you will learn how to manage the channels, add/remove them
and scan a satellite for new channels with the application DVBViewer TE in
combination with your type of DVB board (SkyStar 2 TV PCI, AirStar 2 TV PCI
CableStar 2 TV PCI, SkyStar USB, AirStar USB)

Step four: IP Multicast

In this chapter the IP multicast streaming functionalities of DVBViewer TE are
described. Within this chapter you will learn to manage the function within the
DVBViewer TE and how to receive the stream with the VLC Player.

c The behavior of the software regarding TV and radio reception is similar.

Most functions described within this document will be available with TV and
radio reception.
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Chapter 2: Watch TV with DVBViewer TE

Summary

This chapter is divided into three parts. In the first part, the DVBViewer TE GUI
(graphical user interface) and the main functionalities are introduced. In the second
part, the more advanced features like the EPG or the PVR are described. The third
part shows, how to use the DVBViewer TE in combination with your keyboard,
mouse or the available TechniSat remote control.

This chapter requires a correctly configured channel list. If you are using
ASTRA 19.2°E or Eutelsat Hotbird 13.0°E, the DVBViewer TE is already set
up. If you use another satellite, you have to add this to your channel list first,

before trying to receive a channel. Read chapter 4 for managing your
channel list first.

First startup

If you start DVBViewer TE for the first time, the remote control selection dialogue will
appear:

Rénmte Control |

Femate Contral |

Flease select your IR receiver

= Bitte wihlen sie |hren IR Empfanger

I H Choisit votre receptewr IR 5.v.p.

W Selezione vostra riceverte |R per favors

(%) Mo Remote
() Use WinLirc
() Use USE HID

[ ok [ cancel ]

Figure 2.1: Remote Control selection: “No Remote”

If you don’t want to use a IR receiver, you have to select the option “No Remote” and
press the OK button.
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Configure COM Port IR Receiver / WIinLIRC

If you want to use the TechniSat COM-Port IR receiver, you have to select the option
WinLIRC

Remote Control [E|

Remote Control |

Flease select your IR receiver

= Bitte wihlen sie |hren IR Empfanger

I H Choisit votre receptewr IR 5.v.p.

W Selezione vostra riceverte |R per favors

() Mo Remote
(%) Use WinLirc
() Use USE HID

[ ok || Caned |

Figure 2.2: Remote Control selection: “Use WinLIRC”
Then press the OK Button and you have to configure the WinLIRC application

1. First the following error message will appear:

WinLIRC Error

winLIRC Failed to initialize.
wiould you like to change the configuration
and try again?

Cancel |

Figure 2.3 WIinLIRC

If this message appears, the default configuration of WinLIRC does not match
the needs of your system.
2. Press "OK” to show the configuration tab.

3. Here you have to configure the COM port (e.g. COM1), where your IR
receiver is attached.

WinLIRC Configuration

Pot |BEEH - | [ Peceiver e - Leamn
> ™ A device [+ DCD device
Spesd (115200 - J Analyze
Sense |ﬂut0detect 'i “Wirtual pulse I 00 Bawe Codes

Uzually, speed should be 115200, Sometimes other values are better

[ animay (enable DTR] sl
[ Mo trawicon. (Main window iz available by starting program again)
Tranzmitter seltings - -
I Irwerted [ hardware carier 0 DTR O T®

Canfig | Browsze. .

Figure 2.4 WinLIRC Configuration

4. You also have to choose the configuration file, which contains the
configuration for your remote control. Press the “Browse” button and choose
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the file “technisat.cf” (default location: “C:\Program Files\DVBViewer TE”) in
the appeared “Open” window. Click “Open” to finish the select.

Loak in: ].&J'D\-"B\-"iewerTE ﬂ ! |‘j‘: Eq~

5._‘] Capture |3 Transponders
| aFilters (=] techisat. of
(himages

|Zilanguags

EPlugins

‘i,"_“] Skins

File fiame: ]technisat
Filess of bypes |Configwation Files ["chg;” conf;™ of Mic) _*J Cancel

Figure 2.5 WinLIRC Open Configuration Files

5. Now your configuration has been completed. Choose “OK” to finish the
configuration and start WinLIRC.

WinLIRC Configuration

Patt ]CDI‘\'H LJ — Receiver type— | Leam ]

™ A device [+ DCD device

Speed [115200 =] | | Analyze
Sense |ﬂut0detect '1 “Wirtual pulse I 00 Bawi Codes

Uzually, speed should be 115200, Sometimes other values are better

[ animax [enable DTR)
; L 5 / / ; Caneel
[ Mo trawicon. (Main window iz available by starting program again)
Tranzmitter seltings - =
I Irwerted [ kardwars camier & DTR © TH

Canfig iC:'\F’mgram Filz2\DWEWiswearTE \tachnisat.of Browsze. .

Figure 2.6 WinLIRC Configuration completed

Configure USB HID IR Receiver
If you have a USB IR receiver you select the third option and press the OK button.

Remote Control [E|

Remote Control |

EE Please select your IR receiver

= Bitte wihlen sie |hren IR Empfanger

I H Choisit votre receptewr IR 5.v.p.

W Selezione vostra riceverte |R per favors

() Mo Remote
() Use WinLirc
(% Use USE HID

[ ok || Caned |

Figure 2.7: Remote Control selection: “Use USB HID”

The USB HID IR receiver uses keyboard commands to control the application. No
additional configuration is required.
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Device support

No device

If no compatible TechniSat DVB device is available during startup of DVBViewer TE,
the following error message will appear:

Error
! 'j Mo valid DYE device Found!

Figure 2.8: Message “No valid DVB device found!”

DVBViewer TE can be used as multimedia player for files, which where recorded with
this application.

Single device

If you use one single device with DVBViewer TE, the application will recognize the
used device automatically and present the GUI for the used frontend type (DVB-S /
DVB-T / DVB-C).

Multiple device

If you have installed a multiple number of compatible TechniSat DVB cards / USB
devices, DVBViewer TE will automatically recognize the devices installed at the first
startup.

You will be able to use your TechniSat DVB-PC Stars devices within the same
session of DVBViewer TE, but not simultaneously.

It is possible to switch from one device to another device similar to the multi tuner
system used within the TechniSat HD-Vision 32.

The simultaneous operation of multiple devices is not supported within
DVBViewer TE. You will not be able to record one channel while you watch

another channel.
c If you scheduled a recording DVBViewer TE will start the recording without

any further information to the user. DVBViewer TE will use the required
device for this operation automatically.
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O ptions [‘E]

Preferences:
The Options are changing the appearance and behaviour of the DVE Viewer,

Ca General Hardware
1 Erhanced :
= (3 Teletext &EPG Device: Tunerkype;
Teletext T v |
ERG D'-v'EF F||e Dewce
SighFern Infa Shate:
Subtitles |Nurrn.al W |
1 Recorder
(21 Metwork Sebtings
= (3 Input )
Keyboard [Irtade For lowe Bandwidkh {USE 1,1)
WinLIRC
Mouse
[ | Harchuare

Scan Devices
o —

[[15top stream wihile buning

| ok ][ cancel ]

Figure 2.9: Options menu “Hardware”

If you add or remove one or more TechniSat DVB-PC Stars devices you have to
update the device list manually. For this operation you must start the options menu
and open the hardware menu. Here you have to click onto the “Scan Devices” button
for refreshing the device list.

Watching TV -introduction

Main window
75 CHANNEL | ¥

Figure 2.10: main wmdow during DVB receptlon

The main window is divided into three areas:
The first is the menu bar, which contains text-based options to the user.
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The second is the display area. This is the window, where TV programs are
displayed. The On-Screen display and the EPG info will also be displayed in
this area.

The third is the control and tool bar. This area provides access to main
functionalities of DVBViewer TE such as EPG, teletext, PVR/time shift and
the volume control.

NP EEEO O -~ @ TechniSat .

Figure 2.11: control and tool bar during DVB reception

To start the time shift function of DVBViewer TE simply press the “Play/Pause”
button. If you press the “Play/Pause” button again, the time shift toggles from paused
to playback. If you press the “Stop” button, time shift will stop and DVBViewer TE
switches back to live playback.

The “left” and “right” buttons are used to switch channels up and down.

The next two buttons will open and close the teletext window and the EPG window,
which are both described in this manual.

The record button is used to start and stop manual recordings. The buttons indicates
a recording running, when the button is colored gray.

The left slider indicates the position within the program running. This slider indicates
the current position only, if EPG data are sent as part of the TV channel.

The right slider is used to control the volume. Drawn to the left will decrease the
volume, drawn to the right will increase the volume. Using the yellow “loudspeaker”
buttons, you decrease or increase the loudness. If you want to mute the DVBViewer
TE, you have to choose this option in “Settings” => "Mute” or use the mute button at
the right to the volume slide bar.

Watching TV - advanced features

Time shift

Time shift provides the possibility to pause and resume the running program for short
breaks. After you have held the running program, the DVBViewer records the running
program. After you have resumed the playback of the video, you can jump forward
and backward within the recorded time.

OCMHEEEEOOL/I—m |~y @ TechniSat
Figure 2.12: control bar during DVB reception

The time shift will be started after you have pressed the pause button of the control
bar, the stop button of your remote control or the "ESC" key. After the time shift has
started, the DVBViewer TE records the running program into a DVBViewer TE time
shift file, saved on the local hard drive.

To resume playback during time shift, you have to press the play button in control
bar, to hold the program again you have to press the pause button again. If you are
using the keyboard or remote control, you can toggle between play and pause using
the STOP-button on your remote or the "ESC" Key on your keyboard.
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If you want to leave the time shift mode of DVBViewer TE, you might do this by
switching the channel you are currently watching, the time shift will be canceled
immediately. It is also possible to leave time shift by pressing the stop button in
control bar to stop time shift and resume live mode.

If a recording is scheduled while you are currently using the time shift
function, the time shift will be canceled without notice and the recording will
start immediately.

Channel list

If you want to choose a TV or radio channel directly without clicking through the
whole channel list, you might do this using the channel list of DVBViewer TE. Just
choose “Channel” => “Channellist” in menu bar or click directly the “Channellist”
button located in the tool bar.

B Channellist @

Edit and Tune Channels e
Allows to change the channel list and .
the automatic channel scan. !

| Charrels | Edit || Charmel Scan

Search |BECONE Engand (Londan) | | 1121
|y English Al

B 1T News Channel S

b ten & dotors

? FERC ONE England [London]

¥4 EEC OMNE Marthern lreland

4 BEC TW/O England

¥4 BBC THREE

b CEEC

W4 BEC Mews 24

P EEC FOUR

¥4 CEechics

P4 EEC OME England (whest Mid

4 EBC ONE England (North s

¥4 EEC OME England [Lincs &

W4l BEC OME England [ arkshir

¥% BEC OME England (E ast Mid

¥4 EEC ONE England (East-M

g BBC OME Wales

e EEC OME Scotland

i BEC TWO Wales

¥4 EEC Tw/0 Scotland

¥4 BEC T/0 Morthem Ireland

e BEC OME England [West)

b

T T e

Figure 2.13: Channellist “Channels”

The “Channels™ tab of the channel list is arranged like a directory tree. Choose your
satellite, choose the type of content (Video or Audio) and select your channel. To
choose a channel, you have to double-click onto this channel, DVBViewer TE
switches directly to the selected one. For information about editing existing channels
or scan for new channels, read chapter 5.

MPEG-4/H.264 content is marked with the suffix ‘h.264" within the channel

A list. Please note that you need to have a special H.264 decoder installed for
MPEG-4/H.264 playback. If no MPEG-4/H.264 decoder is present, those
channels cannot be started.
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EPG

The Electronic Program Guide is a service of the DVB technology, which offers
additional information about the running program to end-users. DVBViewer TE is
capable to receive that kind of information and offers two methods of presenting that
information.

Not all TV station provides EPG data. That information can only be
displayed, if the chosen TV channel provides EPG data.

c Please ensure that the current system date and time is set up correctly.

EPG onscreen display:

The first method is to insert the content into the display area. This option is useful if
you want to know which program is currently running and which program follows.

To display the EPG data into the view area, select “DVBViewer TE” => “Show EPG".

Figure 2.14: main wmdow durmg DVB receptlon W|th EPG OSD

There are a couple of designs for the EPG onscreen display available. To change the
settings, open the options window and select “Teletext & EPG”.
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Preferences:
The Options are changing the appearance and behawviour of the DWE Yiewer,

|23 General
1 Erhanced
= [ Teletext &EPG
Telebext
5 [ags]
SiehFern Infa
Subtitles
1 Recorder
1 Mebwork
= [ Irpue
Kevhoard
WinLIRC
Mouse
(] Hardware
23 scheduler

EFG
] D not receive ERG-Data
Automatic DfFset
GMT difference:

EPG Wisual

[¥] Semi Transparent Display

Sample:

Style B -v”

Send to PR
Lead Time {m) 3

-
-

=
Y
=

Eallaw-up Time (m) |2

Cancel l

Figure 2.15: Options menu “EPG”

Here you can change the appearance settings for the EPG display. If you choose “Do
not receive EPG-Data” the EPG display won't work caused by the fact, that no EPG

data will be available.

The option “Automatic Offset” will enable the synchronization of the GMT offset with
the timezone configuration of your Windows operating system. If this option is
disabled, you have to configure the GMT offset manually.

SFI — TechniSat SiehFern Info

The TechniSat SFI service is an extension to existing EPG services provided by the

broadcasters.

O ptions

Preferences:

|23 General

1 Erhanced

] Teletext &EPG
Telebext
EPG

Subititles
1 Recorder
1 Mebwork
= [ Irpue
Kevhoard
WinLIRC
Mouse
(] Hardware
23 scheduler

The Options are changing the appearance and behawviour of the DWE Yiewer, i,_j‘g
. ;
SighFetn Info
Transpondet: ;12669 | |Yer v
Swrnbolrake: %éZDDD ]
DISEqL: [PosajoptA v
PID: 1808 |
Scan
|. l
[ ok ] [ Cancel ]

Figure 2.16: Options menu “SiehFern Info”
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Within the configuration tab of the SiehFern Info service you can configure the
transponder settings required for the reception of the service.

You start the download process of the service content by pressing the Scan button.
The update process might take between 30 and 45 minutes. You cannot use
DVBViewer TE for any other task while the download of the SFI data is in progress.

The EPG data from SFI service will be merged within the EPG database and can be
accessed by using the EPG Window.

The TechniSat SiehFern Info service is hosted on the satellite Astra 1G at
19.2° E and can be received in Europe only.

c This service is limited to German channels only.

EPG window:

The second method for displaying EPG content in combination with DVBViewer TE is
to use the EPG window. This is arranged like a “TV magazine” with programs sorted
by channel and time.

EPG- the electronic programguide: A& \_
This window displays the broadcasting events. After selecting an event, more informations are shown,
Station | Day | Time Duration - Evert Title S
==} England A we 0700 04:00 Sunrize Sky Mews introduces the la. ..

P BECWald — We 1400 0400 Mews on the Haur Shy Mews brings you the la...
Fd CNM Int. ‘Wwe  18:00 0z:00 Live at Five A complete look at the day'...
;,;‘._, Sky Mews we 2000 00:30 Mews on the Hour Sky Mews bringz pou the la...

Bl CNEC Europ We  20:30 0030 SKY Mews Al the top stories az they br. ..
ﬁ i We  21:.00 01:00 Mews on the Hour Sky Mews bringz pou the la...
| EURONEWS We 2200 0030 Mine O'clock News & comprehenzive round-up...
5 GODCharne 4o 2230 0030 5KY News 21l the top stories as they br...
.é CAMAL CAM, ‘We 2300 0030 SKY Mews at Ten A comprehensive round-up...
Travel ¥ owie 2330 0030 SEY News Al the top stories az they br. ..
£l > Th 00:00 01:30 Mews on the Hour Sky News brings you the la... !
Cretailz
Event: News on the Hour Start: |'we 27.07 1400
Title: Sky Mews brings you the latest home and intermational news, financial updates, top & | Duration: | 04:00

S ky News brings you the latest home and intemational news, financial updates, top sporting headlines and weather summaries,

Cone] [ oc
Figure 2.17: EPG window

Using the EPG window, you gain access to additional information, which are not
shown within the EPG display. It is also possible to save the EPG data to your hard

drive as HTML TV magazine. For this purpose the “Save EPG” button opens the
save as dialog.
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Save As @@

Savein |.D My Documents v_| P * [ b

-

My Recent

Dacurmemts
=
L

Dezktop

by Diocuments |
or
My Camputer
‘;;] File name: :HTMLepg YI . Save
) I — ==
MyMNetwork  Saveashper | EPG-Data [ him ) vl

Figure 2.18: Save as dialog

Enter the location and the name of the files and press the “Save” button. All known
EPG data will be combined into a set of HTML files, which can be displayed with a
web browser

2N DVBViewer EPG - Microsoft Internet Explorer

File Edit Wew Favorites  Tools  Help z-"
@ Back ~ [ li] @ ;“, /._ ) Search ‘\"’ Favarites 6_?{ [ o _,; ﬁ
Address : HTMLepg. html e
Eurosport A o
Phoenix We 27.07.200507:00 Sky News
DW-TV I
EuroNews | 07:00 (0400) Sunrise Sky News introduces the latest news keadlines,
CONN Tut. ‘comprahansive weather reports, finamcial updates and o daily
newspaper check.
Sky News 11:00 (0300) SKY News Today Sy Mews brings you the latest breaking
Bavern 1 starigs, live corunent on the morning s issues and your chance fo
put questions &y email and text to the people in the headlines.
RAI?IO : 14:00  (04:00) News on the Hour Sy News brings you the latest home and
mmltilaults nternational nevis, financiol updates. top sporting headlines and
SR 1 wwaather summaries.
B M 18:00 (0200) Live at Five A compieie look at the day's top staries and the
L i issugs behind them, with full sport, showbiz and weather reparts.
Bavein 4 20:00 (00:30) News on the Hour Sky News brings you the latest home and
TKlassilk 3 international news, financial updates. tap sporting headlines and
< | 3 weather supumarias. ' ¥
EI ‘J My Computer

Figure 2.19: Browser with opened DVBViewer TE HTML EPG

The second option is the capability of sending programs directly to the DVBViewer
TE recorder module. This option is described in chapter 4 “Using DVBViewer TE as
PVR”
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Teletext

Using DVBViewer TE you also gain access to the teletext services of most TV
stations. Open the teletext window by using the Teletext button in Toolbar or using
the menu “DVBViewer TE” => “Teletext”.

B Teletext LER

W01 2 3 4 5 6 7 8 9 0 & = «||»

DVBxTT CEEFAX 100 Wed 27 Jul 14:04/48

CEEFRH

Figure 2.20: Teletext window

The usage of this application is very simple. Enter the page number using the
number buttons in the toolbar of the Teletext window or enter those numbers using
your keyboard or remote control. Use the forward/reverse button nearby the number
field to navigate through the pages. You might also access sites by clicking on
displayed page numbers with the left mouse button.

Subtitle

The DVBViewer TE supports showing and recording of teletext and DVB subtitles. By
selecting the menu "View" => "Show Subtitle" the option will be enabled.

Teletext subtitles:

Subtitle

Subtitle Teletextpage:

@ Teletest Subtitle [aeg

iy

| ok | [ coned |

Figure 2.21: Subtitle dialogue for teletext subtitles

After the subtitle page number is entered and the "OK" button is pressed, the subtitle
teletext will be shown in display area.

If the specified subtitle teletext page is not available, no subtitle will be
shown in display area.
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DVB subtitles

Subtitle Teletextpage:
T = '-__'.E.:-'-:I :.I. HINif=3 I_. |
(£ DVE Subitle [Hugarian B

| ok | [ coned |

Figure 2.22: Subtitle dialogue for DVB subtitles

After selecting the language of the DVB subtitle, press the “OK” button and the
subtitle will be shown in display area

CHANMEL TYIEW T SETTINGS

~— . d ‘\--:'_-: >
The actual signed autograph,
if it hadn't had your name on it,

Figure 2.23: Main window during DVB reception with subtitle

If the subtitle function is enabled and you start a recording of this program, the
subtitle will also be recorded. If you playback a recorded program with recorded
subtitle using DVBViewer TE, the option "View" => "Show Subtitle" is available. If you
enable "Show Subtitle", the recorded subtitle will be shown in display area.

Selecting the menu "View" => "Show Subtitle" again will disable the subtitle display.
The teletext subtitle function requires a channel with teletext and at least one
subtitle page. If the channel does not provide teletext information, this option

is unavailable.

The DVB subtitle function requires a channel with DVB subtitle information. If
the channel does not provide those data, this option is unavailable.
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Configure the application

Within the DVBViewer TE options menu you can configure most functionalities of
DVBViewer TE to your needs. First the general and enhanced options are
introduced.

“General” options
Within the general options you can configure the main settings of DVBViewer TE.

Options
e
Preferences: I
The Options are chanaing the appearance and behawiour of the DYWE Yiewer, I}.—‘j
= e Settings-
[ Enhanced
= 3 Teletext &EFG Use X con Stile
Teletext [[] Uze Skir-Engine ;
EPiS [w] Hide: the mouse cursor in fullzereen mode in secs: 2 =
siehFern Info [1 Hide: the Titlehar
subtitles Priesvent S creen saver
[ Recorder [T Use first CPU arly
[ Mabunork rnisne
= (] Input
Keyboard = =5
|
WinLIRC B i set
Mause
(3 Hardweare
(23 scheduler
ok ] [ Cancel

Figure 2.24: Options “General”

Use XP-Icon Style:
This option can be used only while the skin engine is disabled. It toggles
between the XP style icon set and a alternative icon set.

Use Skin-Engine
This option toggles the skin engine of DVBViewer TE on/off.

Hide the mouse cursor in fullscreen mode in secs
This option configures the timeout, when the mouse cursor will be hidden in
full screen mode.

Hide the title bar
This option toggles the title bar on/off and is available with disabled skin
engine only.

Prevent Screen saver
This option toogles the screen saver prevention on/off.

Use first CPU
This option enables the usage of the first CPU within SMP/HT/Dual Core
systems.

Language

Here you can select the GUI language. Select the required language and
press the set button.
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EIA 608 — Closed caption
This option configures the delay transmission and appearance of closed
captions (if available).

Enhanced options

Preferences: T
The Options are changing the appearance and behawviour of the DWE Yiewer, (== \g
3 Goneral I Erhanced

=
= [ Teletext &EPG [lgrore Eromessages
Telebext Show Emor anly on D50
EPG Remember the last channel = &
SishFern Infa [w] Zapping Delay in milizeconds jLoo | =
Subtitles Show Contralbar
[ Recorder
(1 Nebwrork Renderer Dutput
= ] Imput
Keyboard | Unchanged & | Show DYE-Yiswer in:
WinLIRC : =
Mouse Fast Charinelswitch (3 Taskbar orly
(L3 Hardware Uze DVESource for files ) Gystern tray anly
(23 scheduler ) Showe in bioth
ok ] [ Cancel

Figure 2.25: Options “Enhanced”

Ignore Error messages
Toggles error messages on/off.

Show Error only on OSD
Disables/enables error messages shown as overlay and not as pop-up
window.

Remember the last channel
If this option is enabled, DVBViewer TE will tune the last channel after startup
automatically.

Zapping Delay in milliseconds
The delay time will be use to delay channel switch command.

Show Controlbar
Toggles the controlbar on/off and is available with disabled skin-engine only.

Render Output
Configures the render output format.

Fast channelswitch
Toggles the fast channel switching feature on/off. If this option is enabled,
DVBViewer will not retune, if the selected channel is located on the current
transponder.
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Show DVB-Viewer in...

This option toggles the appearance of DVBViewer TE between the taskbar,
the system tray or both.

The other option windows are described within the following chapters of this
document within the chapter context.
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Control the application

Keyboard
A list of assigned keyboard commands is given in Appendix B.

If you want to change the default settings to your needs, you might do this using the

“Keyboard” tab in “Settings” => “Control”

Options
2 .""_-“l -
Preterences: f
The Optionz are changing the appearance and behawiour of the DWE Wiswer, kv‘j
0 General Kevboard:
[ Enhanced : .
= (3 Teletext % EPG ! Key Action Al
Telebext Fause =
EPG Blways On Top F1
SiehFern Info Hide Menu F2
subtitles | Show Statusbar F3
3 Recorder Show Toolbar F4
— Fullscresn F
(] Metwark Evit EEE
= (] Input
;) e vboard Channelist c
WinLIRZ Channel Minus Covin
Malse | Channel Flus Up
(3 Hardweare | g?\-’? Chh‘:lﬂﬂﬂ ETEJ. +5
= ation Minus aDown
el ‘ Station Plus Pglp el
l ok ] [ Cancel l

Figure 2.26: Options menu “Control Keyboard”

If you use a remote control with the USB IR receiver, you also have to
A configure the settings of the remote control within the keyboard

configuration. The USB IR receiver uses keyboard commands to control the

application.

The USB IR receive is not compatible to WinLIRC.
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Mouse Wheel

If you want to change the default settings to your needs, you might do this using the

“Mouse” tab in “Settings” => “Control”

Options

P

references:

The Options are chanaing the appearance and behawiour of the DYWE Yiewer,

[ General
[ Enhanced
= (3 Teletext %EPG
Telebext
EPG
SiehFern Info
Subtitles
1 Recordsr
[ Mabunork
= ] Input
Kevboard
WinLIRC

(21 Hardware
23 scheduler

Monse Wheel

¥

|[] Resize
.| Aspect Rakio

| Channel Flus | Channel Minus
| Station Plus | Station Minus
¥ Yalume Up [ Yolume Down

[

ok

] | cancel

Figure 2.27: Options menu “Control Mouse Wheel”
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TechniSat Remote Control with RS232 IR receiver

A list of assigned commands is given in Appendix B for the current TechniSat remote

controls

If you want to change the default settings to your needs, you might do this using the
“WInLIRC” tab in “Settings” => “Control”

Options

Preterences:

[ General
[ Enhanced
= (3 Teletext XEPG
Telebext
EPG
SiehFern Info
Subtitles
[ Recorder
[ Mabunork
= (] Input
Kevboard
Ll Nl IRC

Mause
(21 Hardware
(23 scheduler

The Options are chanaing the appearance and behawiour of the DYWE Yiewer,

L)

&

WinLIR.C:
i Key Action ’\:
Pause STOP
Blways On Top
Hide Menu HENU |
| Show Statusbar
Show Toolbar
Fullscresn BACK
Exik PCVWER
Channellist
Channel Minus D
| Channel Flus [
| Save Charmel
Skation Minus
Station Plus ~ |
[ ok ] [ Cancel l

Figure 2.28: Options menu “Control WinLIRC”
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If you use a remote control with the USB IR receiver, you have to configure
the settings of the remote control within the keyboard configuration. The
USB IR receiver uses keyboard commands to control the application.

The USB IR receive is not compatible to WinLIRC.
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Chapter 3: Using DVBViewer TE as PVR

Summary

This chapter shows how to use the built in PVR functionalities for recording and
playback of DVBViewer TE and also how to play recorded videos with third party
software.

Necessary settings

Before you record files for the first time, you should be sure that there is enough
space available for recording DVB content.

DVB TV channels could create data rates with up to 25Mbit/s. For this
purpose you need more than 10GB of free hard disc capacity for one hour of

recording time.

Options
Preferences: M ;
The Options are chanaing the appearance and behawiour of the DYWE Yiewer, I}.—‘j
0 General Directories
] Enhanced

= Recorder:
= [ Teletext &EPG

Telebext
EPG

i.l:;iEmcum ents analg‘éi:i:.i;g sliﬁl‘ipl-jsers{b.ucum :

Tirne=hifk:

SiehFern Info e — — —
ubtitles !_l:..\.?Dncuments and Settlngs.\ﬁll Users\.pul:um

Pe R e corder Sertings

[ Mabuork

= (] Input SRR d
Keyvhoard | AudiofYideo PS5 (mpeg2) vl
i

Mavies SI_Jht files after

(21 Hardware | 640 | ME

23 scheduler

[IKeep timeshift fils

ok ] [ Cancel

Figure 3.1: Options menu “Recorder”

Specify location with enough free available space.

If you are using the FAT32 file system, you have to split files caused by the
fact, that FAT32 can handle files up to 4GB only. In this case you have to

check the “Split files” checkbox.
You should also split files, if you want to backup the recorded files with CD or DVD

recorders. If you are using NTFS formatted drives and don’t want to save files to CD
or DVD, there is no need to enable the file splitting.
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Record programs manually

To start a manual recording, press the red button in the tool bar. You can also use
the keyboard shortcut or the button on your remote control.

@.Gf@@' iy @)

Figure 3.2: Tool bar during DVB reception

TechniSat |

E— 7| —

The recording starts immediately. If you want to stop the recording, press the record
button again.

If you change to another channel during a recording, the "Recorder is
active!" message appears

DVB Viewer @

) Recardar is activel
el

[ oK, ]l Cancel ‘

Figure 3.3: "Recorder is active!"

If you press "OK", the recording will stop and the DVBViewer TE tunes the chosen
channel. If you press "Cancel”, the DVBViewer TE remains in recorder mode.

The recorded file will be saved in the specified directory.

Record programs automatically

The PVR functionality of DVBViewer TE provides a recording schedule, which can be
programmed manually or by using the EPG.

Your PC must be active and DVBViewer TE must be started for scheduled

A recording. If DVBViewer TE is not started or the system is not active while
passing a scheduled event time the event entry will be discarded without
recording.

c If a recording is scheduled and while you are time shifting a TV program, the

time shift will be canceled without notice and the recording starts
immediately.
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Add events to recorder manually

Using the recorder window of DVBViewer TE it is possible to add multiple events to
the recording scheduler. You'll find the recorder window by choosing “DVBViewer

TE” => “Record Setting”.

Recorder

£

- E)Englsh

I 174 Mews Char

[AFEEC ONE Enals
84l EEC OME Morth

¥4 BBC TWO Engl:

V4l BBC THREE

¥ CEEC

Vil BEC News 24

Vil BEC FOUR

84| CEechies

¥4l BEC OME Engla

¥4l BBC OME Engla

¥4l BBC OME Engla

b4 EEC OME Engla

Vil EEC OME Engla

¥4 BEC OME Engla

Fdl BEC OME Wals:

il BEC OME Scotl:

d RRC T YAle

Programming the videorecorder-timer:
Afker selecting & chiannel From khe channellist, setting the date, begin- and endtime, the [add]
Function inserts the job in the Limer-lisk,

f' Men & Motors —

= Descripkion Date Start
: Diagriosis Murder ZF.07.2005  15:35
Drater Stark:
|27.07 2005 | |52 |2
Channelnumbet: Cescripkion:

1121

= [[] shutdaown after recording

16:20

End:
[1e41 | 2
| 52

U @add | [ update | [ @ Remore | |

Close J

Figure 3.4: Recorder window

To add a new event to the scheduler, enter the event date, start and end time, the
channel number and the event description. You might take the channel number using
the tree view of the channel list located at the left side of the recorder window. Click
“Add” to add the event to the scheduler. If you want to remove an event, choose it
and click “Remove”. If you want to edit an existing event, choose this event and edit
the necessary values. After this, press “Update” and the scheduled event will be

updated.

If you enable the option “Shutdown after recording”, DVBViewer TE will shutdown
your system after finishing the last scheduled element.
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Add events to recorder using the EPG

For all channels, which provides EPG data, you might use the EPG window to add
recording timers to the recorder timetable

EPG- the electronic programguide: /\ﬁ:“
This window displays the broadcasting events, After selecting an event, mare informakions are shawn. :
Station | Dap Time Duratior . Evert Title o)
=1 England Al We 0700 0400 Surrise Sk M ews infroduces the la...

P EECwiorld  We 1400 0400 Mews on the Hour Skyp Mews brings you the la...

b CHM Int, o We 1800 0200 Live at Five A complete look at the day’.
58] 5y Mows We o 20:00 030 Hewss on the Hour Sky Mews blin_gs you the la...
CMEC Ewop wie 2030 am:30 SET Mews Al the top stqnes az they br..
ﬁ n We o 21:00 00 Mewz ot the Haur Skyp Mews brings you the la..
- ELIRDNEWS Wwe 2200 0030 Hine 0'zlock Hews A comprehensive round-up. ..
4 GOD Channe wie 2230 0030 SKY News Al the top stories as they br...
4 CAMAL CAMN. e 2200 020 SKY Mews at Ten A comprebensive round-up..,
A4 Travel ¥ we 2330 030 SEY Mews All the top stories as they br...
£ | > Th 00:00 030 Mewaz om the Haur Skyp Mews Brings you the la... v
Dietals
Ewvent: [Newws on the Hour | Start: e 2707 1400
Title:  |Sky Newrs biings you the latest home and inkemational news. financial updates. tops | Duration: | 04:00

Sky Mews brings pou the latest home and international news, financial updates, top sporting headlines and weather summaries.

o) [ =

Figure 3.5: EPG window

To add events using the EPG, you have to open the EPG window. Select the event,
you want to record and press the “Send to PVR” button.

This event will be added to the recorder scheduler and automatically recorded on
your hard drive.

c If a recording is scheduled and while you are time shifting a TV program, the

time shift will be canceled without notice and the recording starts
immediately.
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Play recorded programs with DVBViewer TE

Play files with DVBViewer TE

To play recorded files with DVBViewer TE, open the video using “DVBViewer TE" =>
“Open Video” or use the “Change TV/Video Mode” button in the tool bar.

LR EO.ECO00 04 —=  ~w ® TochnSst

Figure 3.6: control and tool bar durmg DVB receptlon

After DVBViewer TE has loaded the file the playback will start immediately.

coor llu[lhﬂﬁ
\B I T

6| TechniSst |

Figure 3.7: main window in playback mode

There are several ways of returning to TV mode. Choose a channel by using the
graphical interface, your keyboard or a remote control.

Play files with third party software

Almost every media player like the Windows Media Player 9 is capable for playback
a file recorded by DVBViewer TE.

be installed in the system.

If you want to play a file recorded using DVBViewer TE in a system without
this software, you have to transcode the file(s) to normal MPEG?2 files.

c To playback a file, the TechniSat DVB software and the DVBViewer TE must
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Chapter 4. Managing TV/radio channels

Summary

This chapter shows how to manage TV/radio channels and perform imports and
exports of the database with your DVB-PC TV card. It is divided into three parts, one
for each device type:

SkyStar2/SkyStar USB for satellite reception

AirStar2/AirStar USB for terrestrial reception

CableStar2 for cable reception

SkyStar2 PCI/USB

Edit existing channels

If you want to edit an existing channel in DVBViewer TE channel list, you have to
select this channel in the channel list and switch from “Channels”-tab to "Edit”.

B Channellist @ B3 Channellist
Edit and Tune Channels I/f_ A Edit and Tune Channels ,#{\—
&llows ko change the channel list and - Allows to changes the channel list and
the automatic channel scan. i the automatic channel scan,
| Charnsls cl.it. ] | t.ﬁannel .S.can: | EHannéI..;; Edit | .E.l.iannel.Scani

Search IlBBI:_DNEF: nﬁlanﬂ- .[.i_on_l:lna]_ s
[ ) English ' Al Root |stra 2%
P4 T Mews Channel CeRgERY !Engﬂsh 3

-84 Men & Motorz -
BAC ONE England (Lardon] ' O Enciypted CJacs

b BEC OME Marthemn Ireland Erequency (MHz) 110773

P4 BEC T\ England I

i Syribelrate |z2000

| BBC THREE - !
P4 CREC Bolariky !Horizontal |
f BEC Mews 24 FEC FEC 5/6 w
; EEEBZ?EUSH Viden PID ]5000

¥4 BEC ONE England [west Mid Audio PID ]5001
;‘.— BBC OME England [Hﬂlth Ywl'e Telekaxt PID ‘5003
¥ BEC ONE England [Lines & T T
¥4 BEC ONE England [Yorkshi SR P [p2t |

¥l BBEC ONE England [East Mid LME Selection | Mane w |
:r‘ BBC OME England [East - M LOF (MHE) r' = ;
i BEC OME Wales - L —
P4 BOC ONE Scotland DiseaC | Pas 40t B i
I BEC TWwil Walee
¥4 BEC T'wWO Scotland
I BEC T Northern lreland | ead || oele | | todare |
P BEC ONE England [West B |

I Impart " Export ] [ Clearall ] I ok ] [ Impiort " Export ] I Clear &l ] [ ok ]

Figure 4.1: Channellist “Channels” and “Edit”

Here you have to enter the new values and press the “Update” button. The changed
settings for this channel will be added to the current channel list.
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Edit satellite parameters (DISEqC settings)

If you use DISEQC settings, which differ to the default settings of DVBViewer TE, you
have to change those settings for each satellite you are able to receive using your
equipment. For this purpose choose a satellite in the channel list and switch to the
tab “Edit”. The settings for the satellite will be displayed.

& Channellist @
Edit and Tune Channels /{\—
Allows to change the channel list and -
the automatic channel scan. \

:[.:hanne.l.;;g Edit ;_E.H.anne.IScan:

Mame

Diseal: [Pos a/0pt B v

| Delete | | updste |

| oot | Expor | [ Cleman| | ok |

Figure 4.2: Channellist “Edit” satellite settings

Here you have to select the correct DISEQC settings for the satellite and press
update to confirm the change of the DISEqC parameter. Those settings will be valid
for all TV and radio channels which are listed within the channel list of this satellite.

Using the “Clear All” button you can remove the whole satellite tree of the selected
satellite.
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Add/Remove channels manually
If you want to add or remove channels manually, you also have to use the edit tab.

Channellist E‘ B3 Channellist
Edit and Tune Channels (( - Edit and Tune Channels ,J{
&llows ko change the channel list and Allows to changes the channel list and
the automatic channel scan. ; the automatic channel scan,
Channels |Ecl|t .__:;_Eﬁannel .S.éan_; ___Eﬁannél..;;j Edit i_El}.annéI”S.can_'_ !
Seach [BBC ONE Englard fLondor] | [1121 | |l yare E |
=) Enalish |l Root fistra 26°E l
Pl 1% News Channel .
Cakeqaor English
tder & Motars =S 2 |
[ Enciypted [Jacz
Erequency (MHz) |10??3
B8 EEC Tl England Syrnbolrate 22000
b BEC THREE E
P4 CBEC Bolariky |Horizontal )
FEC FEC 56 w
Wideo PID 5000
Audio PID [s001
BBC OME E ngland [Hﬂlth Ywl'e Telekaxt PID SO0z
Service BID E301
LME Selection Mone »
LOF (MHZ) 575 v
DiseaC | Pas &/0pt B v
[ Add ] l Delete J l Update |
|
I Impart ” Export ] [ Clearall ] I ok ] [ Impiort " Export ] I Clear &l ] [ ok ]

Figure 4.3:Channellist “Channels” and “Edit”

To add a new channel, you have to enter the necessary values; press “Add”...

Channellist

".I‘j Diayau wank ko add kthis channels

[ OF H Cancel l

Figure 4.4: Channellist add channel popup message

...and confirm the appearing message. This channel is now added to your channel
list.

To remove an existing channel, you have to select a channel using the tree view of
the channel list and select a TV station. Then switch to the “Edit” tab and click the
button “Delete”...

Channellist

? )  Doyoursally wank bo delste this channsl?

I 0K H Cancel ‘

Figure 4.5: Channellist delete channel popup message
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...and confirm the appearing message. This channel is now removed from the
channellist.

To clear all channels from the channel list, you have to click the button “Clear All"...

Channellist

<P

: 7
__:/ Diovyou really want ba delete all channels?

[ OK. l[ Cancel ]

Figure 4.6: Channellist delete all channels popup message

...and confirm the appearing message. The channel list should been cleared
completely.

. If you clear an existing channel list, all information will be deleted. Please

create a backup of your channel list before clearing, with the channel list
export function of DVBViewer TE.
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Scan for new channels
Another way of adding new channels is the “Channel Scan”.

B Channellist

Edit and Tune Channels /{\—
Allows to change the channel list and -
the automatic channel scan. & o

Chaninels Edit | Channel Scan |

Root a1 v

LHE Type [fu-tpand |

LOF 1 (MH2) lap

LOF & {MHZ)

LOF 5 (MHZ)

Lizeql :None- =
l Sumbobates »J

Stark Frequency (MHZ) | 10733
Erd Frequency (MHZ)  |12728

Stepsize (MHZ) 5

Status - =

Palarity ; | Frequency |

Faund Symbolrate [ |

Pa7 [ -7 I =0

I J
[l Scan & Update
I Impoirt ]I Export ] lglear f-‘«ll] [ Ok ]

Figure 4.7: Channellist “Channel Scan”

To start a channel scan you should select a satellite root first, DVBViewer TE will
scan for channels using a transponder list for the satellite system selected. If you
want to scan for channels without a transponder list, enter a name for the satellite
only, which is not used by the existing lists.

After selecting the root list, you have to select the used LNB type. The default “Ku-L
Band” LNB is used for frequencies between 10.7 and 12.75GHz with linear
polarization. The other LNB type options are “Ku-C Band” for circular polarization and
“C-Band”.

You need to enter a name for the scanned root, the values for the used LNB and the
frequency area you would like to scan. If you want to update an existing channel list
for a satellite, check the “Scan & Update” option. Press the “Scan” button to start the
scanning process.

Q The scan procedure might take several minutes to complete.
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After the procedure has been completed, you will find the added channels browsing
the specified root name at the end of the channel list. If you updated an existing root,
the channels, which do not longer exist, should be removed and new channels
should be added to the list.

Import/Export channel lists with DVBViewer TE

The third option for adding channels to DVBViewer TE is to import existing channel
lists. For this purpose you need a channel list provided as a file.

& Channellist @
Edit and Tune Channels A
Allows to change the channel list and |
the automatic channel scan. \
Channels Edlt _éﬁanne.l Scan|
Seach |BBC ONE Ergland (London] | [1121
[ i:ﬂEm% ﬁ

Pl 1T Mews Channel
b4 hien & Mokors
= §BBC ONE England [Londe I'l_]
d BEC ONE Marthern Ireland
P BEC TWIO England
¥4 BEC THREE
d CREC

¥4 BEC T'w0 Morthem Irsland
d BBC OME England [\West)

Rl el Ll

w

| oot | Expor | [ Cleman| | ok |

Figure 4.8: Channellist “Channels”

To import an existing channel list to DVBViewer TE, click the button “Import” in the
channel list and choose the file, which contains the channel data.
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Open @

Look ir: ||D by Diocumerts V| ) (P £

" )My efinoks

| |

L ‘a Iﬂ Ty Music
by Fecent 45 Pickures
Documents | [T IETEITES

by Diocuments

=

b

My Camputer

File name: Ichannellist ¥ | [ Open ]

MyMNetwork  Flesoftype: | iniFile [“iri] o | coned ]

Figure 4.9: Import Channellist “Open” window
The information will be added to the existing channel list.

The following file-types can be imported to the DVBViewer TE:
TechniSat Program List (*.txt)
Microsoft Access Database (*.mdb)
SatcoDX Channels (*.sdx)
Ini File (*.ini)

To export your current channel list (e.g. for backup), click the “Export” button in the
channel list and specify the destination directory and file name.

Save As @
Savein ||D My Documents V| 2 e A
Ty iﬁjMy efiooks
| £ i

=

My Recent
Dacurmemts

Fri

K
Dezktop

by Diocuments

=

My Camputer

File name: Ichannellist v | [ Save ]

MyMNetwork  Saveastpe: | IniFile [“iri] o | coned ]

Figure 4.10: Export Channellist “Save As” window

The DVBViewer TE channel list can be exported to the following file-types:
Ini File (*.ini)
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CableStar2 PCI

Edit existing channels

If you want to edit an existing channel in the DVBViewer TE channel list, you have to
select this channel in the channel list and switch from “Channels”-tab to “Edit”.

Channellist @ & Channellist

the automatic channel scan, the automatic channel scan,

Edit and Tune Channels “ Edit and Tune Channels ,ﬂ(
Allows to change the channel list and Allows to change the channel list and ¥

Charrels |Ec||t ,|Ehanne|_5n:an_ :_:éﬁannels_i Edi i_EHannél-gn.:an._; |
Search ibas Erste | 0 | Marre |
F.abel [AM E4] Raak Kabel (QAM B4}
) Mideo
; Cateqgor ARD
= ARD SRR
I e ] []Encrpted [Jac3
| Bayerisches FS Erequency (Khz) |3?SEIEID |
hr;fernsehen symbalrate |E-9EIEI |
by arte
| zrte [fra] QA |QAM B4 _v_|
il SR SUDWEST Ferns.
d ‘WDF Filn
o Yideo PID 1m
M4 0R-dlpha REED |
4l SUDWEST Farns. B Audio PID |10z
b Phoeriy Teletext PID 104
ba TestR . |
! =) ZDFvision Service PID 28106
i) Audio
[ Add ] [ Deleke ] [ Update l

| twport | Ewport | [cleasa| | ok | W[ wpon | Export | | Clesan] | ok ]

Figure 4.11: Channellist “Channels” and “Edit”

Here you have to enter the new values and press the “Update” button. The changed

settings for this channel will be added to the current channel list.
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Add/Remove/Update channels manually
If you want to add or remove channels manually, you also have to use the “Edit’-tab.

Channellist EJ Channellist
Edit and Tune Channels “ Edit and Tune Channels ,ﬁ(
Allows to change the channel list and Allows to change the channel list and ¥
the automatic channel scan, the automatic channel scan,

Charrels |Ec||t |Ehanne|5n:an | Ehannelsl Edi i Ehannél-gn.:an_; |
Search |Das Ersts | [0 | Mame ; i |
- ; Root Kabel (QAM 641 |

Cateqory ARD |

Ie [IEnciypted []acs
P4 Bayerizches FS Erequency (Khz) |3?SEIEID |
. hr;fernsehen symbalrate |E-9EIEI |
7 ELE
b =ne [fra) QA QA 64 v
¥4l SR SUDWEST Ferns.
4 /DR Kidln 7
o Yideo PID 1m
M4 0R-dlpha REED | |
P SUDWEST Ferns. BW fudia PID |10z |
b Phoeriy Teletext PID 104
ba TestR . |
! =) ZDFvision Service PID 28106
i) Audio
[ Add ] [ Deleke ] [ Update l
[ Import ]I Export l [ Clear Al ] [ Ok ] [ Import ][ E=port ] [ Clear Al I [ Ok ]

Figure 4.12: Channellist “Channels” and “Edit”

To add a new channel, you have to enter the necessary values, press “Add”...

Channellist

".I‘j Diayau wank ko add kthis channels

[ OF H Cancel l

Figure 4.13: Channellist add channel popup message

...and confirm the appearing message. This channel is now added to your channel
list.

To remove an existing channel, you have to select a channel using the tree view of
the channel list and select a TV station. Then switch to the “edit’-tab; click the button
“Delete”...

Channellist

? )  Doyoursally wank bo delste this channsl?

I 0K H Cancel ‘

Figure 4.14: Channellist delete channel popup message
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...and confirm the appearing message. This channel is now removed from the
channellist.

To clear all channels from the channel list, you have to click the button “Clear All"...

Channellist

<P

: 7
_:r,‘ Diovyou really want ba delete all channels?

[ OK. l[ Cancel ]

Figure 4.15: Channellist delete all channels popup message

...and confirm the appearing message. The channel list should been cleared
completely.

If you clear an existing channel list, all information will be deleted. Please
create a backup of your channel list before clearing using the channel list

export function of DVBViewer TE.

Scan for new channels
Another way of adding new channels is the “Channel Scan”.

&l Channellist
Edit and Tune Channels A~ \'
Allows to change the channel list and \
the automatic channel scan, !

EEiﬁannélé _!__Edit" J Charinel Scan |

Roat

[ Charmel <= Freq ] [ Symbolates »]
Start Freguency (Kha) I.EEEIEI ]
End Frequency (Khe) lSESUUD

Stepsize (Khz) !.?EIEIEI

Status

Gk |— Frequency |
Fournd | Symbolrate |

I 7 I o [
[ l

[J5ean & Update

| twport | Ewport | [Qeasa| | ok |

Figure 4.16: Channellist “Channel Scan”

This option should be used to scan for available cable TV channels or to update one
root of the existing channel list. You need to choose the modulation type (in our
example QAM64) and to enter the start and end frequency. If you want to update an
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existing channel list for your cable TV system, check the “Scan & Update” option.
Press the “Scan” button to start the scanning process.

Q The scan procedure might take several minutes to complete

After the procedure has been completed, you'll find the added channels browsing the
specified root name in the channel list. If you updated an existing root, the channels,
which do not longer exist should be removed and new channels should be added to

the list.

Import/Export channel lists with DVBViewer TE

The third option for adding channels to DVBViewer TE is to import an existing
channel list. For this purpose you need a channel list provided as a file.

& Channellist @
Edit and Tune Channels ~ \-
Allows to change the channel list and -
the automatic channel scan. !

| Chanrels E_E.dit. I EHannéiScan_

Search :‘I-Duas Erste | D

[ kabel (DAM 64)
=) Video
=) AFRD
- 5 Erste
ayerizches FS
¥ hi-fetnzehen
.J" arte
by aite (fral
¥ SF SUDWEST Ferns,
¥ \WDR Kl
¥4 BR-alpha
e SUDWEST Fems. B
' Phoeris
vy Testh
| ZDFwision
i) Audio

[ Impart " E=port ] Igearﬁ"][ = ]

Figure 4.17: Channellist “Channels”

To import an existing channel list to DVBViewer TE, click the button “Import” in the
channel list and choose the file which contains the channel data.
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Open @

Look ir: ||D by Diocumerts V| ) (P £

" )My efinoks

| |
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by Fecent 45 Pickures
Documents | [T IETEITES
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=

b

My Camputer

File name: Ichannellist ¥ | [ Open ]

MyMNetwork  Flesoftype: | iniFile [“iri] o | coned ]

Figure 4.18: Import Channellist “Open” window
The information will be added to the existing channel list.

The following file-types can be imported to the DVBViewer TE:
TechniSat Program List (*.txt)
Microsoft Access Database (*.mdb)
SatcoDX Channels (*.sdx)
Ini File (*.ini)

To export your current channel list (e.g. for backup), click the “Export” button in the
channel list and specify the destination directory and file name.

Save As @
Savein ||D My Documents V| 2 e A
Ty iﬁjMy efiooks
| £ i

=

My Recent
Dacurmemts

Fri

K
Dezktop

by Diocuments

=

My Camputer

File name: Ichannellist v | [ Save ]

MyMNetwork  Saveastpe: | IniFile [“iri] o | coned ]

Figure 4.19: Export Channellist “Save As” window

The DVBViewer TE channel list can be exported to the following file-types:
Ini File (*.ini)
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AirStar PCI/USB

Edit existing channels

If you want to edit an existing channel in the DVBViewer TE channel list, you have to
select this channel in the channel list and switch from “Channels”-tab to “Edit”.

Channellist EJ & Channellist
Edit and Tune Channels Edit and Tune Channels ({—
Allows to change the channel list and Allows to change the channel list and Y
the automatic channel scan. ! the automatic channel scan.
Charrels |Ec||t _dChanneI .S.n-:.ani_ Ehannelsl Edit i Ehannéluﬁ-n.:an.:
Search EME I :E3ﬁéT Nara IM6|
g Temestial [EUR) Roat Terrestrial (ELRY
= Y'deo Cateqgory BCE
[CJEncrpted [Jacz
Frequency (Khz) | 191500 |
J Eurasport h
4 Regio TV 1
§ oice Bandwidth | v
1 Regin TV 2
Yideo PID | 100
Audio PID 201
Teletext PID o
Service PID &
l Add J [ Delete ] [ Ipdate ]
[ Impiort ]I Ex=part ] [ Clear Al ] [ Ok ] I Iport ]I Ewport ] [ Clear Al ] [ Ok ]

Figure 4.20: Channellist “Channels” and “Edit”

Here you have to enter the new values and press the “Update” button. The changed

settings for this channel will be added to the current channel
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Add/Remove/Update channels manually
If you want to add or remove channels manually, you also have to use the “Edit’-tab.

Channellist EJ Channellist
Edit and Tune Channels K¥ Edit and Tune Channels ({—
Allows to change the channel list and Allows to change the channel list and Y
the automatic channel scan. ! the automatic channel scan.
Charrels |Ec||t J|Channel .S.n-:.an_:_ | Ehannelsl Edit i Ehannéluﬁ-n.:an._:
Search EME ] :E3ﬁé_] Nara EMf‘l
[ E Temestial [EUR) Roat Terrestrial (ELRY
= Y'deo Cateqgory BCE
=) BCE
[CJEncrpted [Jacz
=) Digiterine Frequency (Khz) |1915EID |
7 Eurcspart h
| Fegio TV 1
§ oice Bandwidth | v
1 Regin TV 2
Yideo PID | 100
Audio PID 201
Teletext PID o
Service PID &
l Add J [ Delete ] [ Ipdate ]
[ Impiort ]I Ex=part ] [ Clear Al ] [ Ok ] I Iport ]I Ewport ] [ Clear Al ] [ Ok ]

Figure 4.21: Channellist “Channels” and “Edit”

To add a new channel, you have to enter the necessary values, press “Add”...

Channellist

".I‘j Diayau wank ko add kthis channels

[ OF H Cancel l

Figure 4.22: Channellist add channel popup message

...and confirm the appearing message. This channel is now added to your the
channel list.

To remove an existing channel, you have to select a channel using the tree view of
the channel list and select a TV station. Then switch to the “edit’-tab; click the button
“Delete”...

Channellist

? )  Doyoursally wank bo delste this channsl?

I 0K H Cancel ‘

Figure 4.23: Channellist delete channel popup message
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...and confirm the appearing message. This channel is now removed from channel
list.

To clear all channels from the channel list, you have to click the button “Clear All"...

Channellist

<P

| : £
_:r,‘ Diovyou really want ba delete all channels?

[ OK. l[ Cancel ]

Figure 4.24: Channellist delete all channels popup message

...and confirm the appearing message. The channel list should been cleared
completely.

. If you clear an existing channel list, all information will be deleted. Please

create a backup of your channel list before clearing using the channel list
export function of DVBViewer TE.

Scan for new channels
Another way of adding new channels is the “Channel Scan”.

& Channellist
Edit and Tune Channels ~ \-
Allows to change the channel list and \
the automatic channel scan. !

Ethannels.f__lgc.lit. J Charinel Scan |
Root

Channel == Freq

Start Fregquency. (Kha ISEIEIEIEI

End Frequency (Khz) | 55000 |

Stapsize (Khz) i.E-EIEIEI |
Statug

Bandwadth | | Freguency |

Found i Symbalrate |

I 7 N 0 [
| J

[J5zan & Update

| twport | Ewpot | | Clemsn || ok |

Figure 4.25: Channellist “Channel & Scan”

This option should be used to scan for available terrestrial TV channels or to update
one root of the existing channel list. You need to choose your region (Europe,
Australia or Taiwan) and to enter the start and end frequency. If you want to update
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an existing channel list for your DVB-T region, check the “Scan & Update” option.
Press the “Scan” button to start the scanning process.

Q The scan procedure might take several minutes to complete.

After the procedure has been completed, you will find the added channels browsing
the specified root name in the channel list. If you updated an existing root, the
channels, which do not longer exist, should be removed and new channels should be
added to the list.

Import/Export channel lists with DVBViewer TE

The third option for adding channels to the DVBViewer TE is to import an existing
channel list. For this purpose you need a channel list provided as a file.

B Channellist @

Edit and Tune Channels /\“}-
Allows to change the channel list and -
the automatic channel scan. !

| Chanrels E_E.dit. I EHannéiScan_
Search [MB | 6308
[ Temestial [EUR)
=) Video
=) BCE
F Evrasport
= Fegio TV 1
" Spice
™ Regin TV 2
=) Audio
I Impiort " Ex=part ] I Clear Al ] [ Ok ]

Figure 4.26: Channellist “Channels”

To import an existing channel list to the DVBViewer TE, click the button “Import” in
the channel list and choose the file, which contains the channel data.

42 Version 4.4.1



TechniSat DVB-PC TV Stars - Users Guide Part DVBViewer TE
Chapter 4: Managing TV/radio channels

Open @

Look ir: ||D by Diocumerts V| ) (P £

" )My efinoks

| |

L ‘a Iﬂ Ty Music
by Fecent 45 Pickures
Documents | [T IETEITES

by Diocuments

=

b

My Camputer

File name: Ichannellist ¥ | [ Open ]

MyMNetwork  Flesoftype: | iniFile [“iri] o | coned ]

Figure 4.27: Import Channellist “Open” window
The information will be added to the existing channel list.

The following file-types can be imported to the DVBViewer TE:
TechniSat Program List (*.txt)
Microsoft Access Database (*.mdb)
SatcoDX Channels (*.sdx)
Ini File (*.ini)

To export your current channel list (e.g. for backup), click the “Export” button in
channel list and specify the destination directory and file name.

Save As @
Savein ||D My Documents V| 2 e A
Ty iﬁjMy efiooks
| £ i

=

My Recent
Dacurmemts

Fri

K
Dezktop

by Diocuments

=

My Camputer

File name: Ichannellist v | [ Save ]

MyMNetwork  Saveastpe: | IniFile [“iri] o | coned ]

Figure 4.28: Export Channellist “Save As” window

The DVBViewer TE channel list can be exported into the following file-types:
Ini File (*.ini)
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Sorting channels
Within the DVBViewer TE it is possible to alter the order of the channels.

One method is to rename the folders, in which the channels are located. Using this
mechanism will create a new folder at the top of the satellite root. Please select the
channel you would like to place into another category. Then switch to the “Edit” tab
and rename the category to the new category name. This might be a name, which
already exists or this might be a new name. New categories will be put at the top of
the list.

The other method is to move the channels up and down until they are at the position
you prefer. For moving one channel up or down, press and hold the “CAPS” key and
use the up or down arrows to move the channel up or down.

It is not possible to move channels from one satellite to another and it is also
not possible, to move a TV channel into a radio channel list or a radio
channel into a TV channel list.

Example

Within our example, we want to get all major BBC channels into a folder named BBC.
Therefore we select one of the BBC channels first — in our example the channel
“BBC Four”.

& Channellist
Edit and Tune Channels A
Allows to change the channel list and e
the automatic channel scan. < &

| Charrels | Edit || Charmel Scan
Seach |BECFOUR | 127
gl Azt 19 E Al
d Hotbird 13°E il
bgd| fietra 25°E

I3 Yideo

| Englizh

I 17 News Channel
¥4 hen & Motors
P4 EEC ONE England (London)
W4 BEC OME Northam lreland
e EEC Tw/O England
¥4 BEC THREE
bl CRRC
¥4 BEC Mews 24
[E415EC FOUR
W4l CEechics
¥% BEC OME England [west Mid
¥4 EEC ONE England (North e
¥4 EBC ONE England (Lincs &
e EBC OMNE England [¥ arkshin
¥4 BEC OME England [E ast Mid
P4 EEC ONE England (East - M
¥4 BBC ONE "wWales
Y EEC OME Scotland

[alaY ne ORI

e all|

] e el

Figure 4.29: Channellist “Channels”
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Now we switch to the edit tab and replace the category name named “English” with

“BBC” and press the update button.

B Channellist

Edit and Tune Channels

the automatic channel scan.

Allows to change the channel list and

EJ &1 Channellist

Edit and Tune Channels
Allows to change the channel list and
the automatic channel scan.

| Chanrnels| Edt | Chamnel Sean |

| Charnels| Edt | Channel Scan |

MName BBC FOLR | MName BBC FOUR

Bt fstra 28°E Rt fstra 28°E

Cateqory i Category BBC

[CEnchpted [CJacz [CJEncrpted [Jacz
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Polarity Hatizantal W | Polarity | Harizantal s
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fudio PID 53t | tudioPp 5301

Teletext PID 5203 | W 1eletest PO |50z

Service PID BE1A Service PID B316

LME Selection More - LB Selection Mone

LOF (MHz) 5750 v o (e 5750 v
Dizeql | Hone w | Diseql | Hone v
l Add ‘ [ Delets ] l Lpdate J l Add J [ Delete ] t |Update |
[ Import ]I E=port ] [ Clear &l ] [ Ok ] I Import ]I Export ] [ Clear &l ] [ Ok ]

Figure 4.30: Channellist “Channel” and “Edit”
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Now there is a new category named “BBC” at the top of the channel list.

B Channellist

Edit and Tune Channels
Allows to change the channel list and
the automatic channel scan.
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Figure 4.31: Channellist “Channels”

Now we can start to move the channels into this folder by renaming the category or
by moving the channels up to the category “BBC”. In our example we now move the
channel “BBC ONE England (London)” to the category “BBC".
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Figure 4.32: Channellist “Channels” before and after channel move
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Chapter 5: IP multicast Streaming

Summary

This chapter will introduce the IP multicast streaming functionalities, which are part of
the DVBViewer TE.

Recommended system requirements

Supported operation systems:
Windows 2000 Professional/Server (service pack 4 required)
Windows XP Home Edition/Professional (service pack 2 required)
Two computer systems, both equipped with fast Ethernet network adapter
cards, which are capable to handle at least 100MBit/s
Direct connection cable
or
100/1000 Mbit/s Ethernet switch
or
100/1000 Mbit/s Ethernet hub

Important information

This HOWTO requires two computer systems, which are configured to operate in a
local area network (LAN) environment. The internal IP network settings should be
configured correctly and the wiring and distribution components should be connected
correctly.

To stream a normal TV station, you have to ensure, that your network is
capable to handle a transfer rate of up to 15MBit/s. If you want to stream
HDTV channels, you will need up to 80MBIt/s.

Network streaming works well at a data rate of up to 8MBit/s. If you want to
stream channels, which requires more than 8MBit/s, it should work properly,
but this depends on the quality of the used infrastructure components. Some
switches cannot handle higher bandwidth over a long time period and might
break down during operation. The same is also valid for SoHo broadband
routers with integrated switches used for broadband connections.

You need an MPEG-2 software decoder installed on the streaming client
machine to decode the received DVB content.

WARNING:

If you want to use IP multicast transfers in large-scale environments, ensure
that the switching components are capable to handle multicast transfers and
the network routers in this environment are configured to block IP multicast.
Otherwise heavy network problems might occur. Contact your system
administrator first, before starting a multicast stream in your environment.

op b b
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Streaming of one TV channel trough a network

Building a network environment for IP streaming

The common system requirements are listed below:

PC 1:
- One operable DVB-PC TV Stars device

One configured network interface (100BaseTX or 1000BaseTX)

3D AGP/PCle Graphic card with hardware acceleration
- DVBViewer TE
PC 2:

3D AGP/PCle Graphic card with hardware acceleration

A streaming client software installed (e.g.: VideoLAN Client)

In our example we are using two systems:

One configured network interface (100BaseTX or 1000BaseTX)

Satellife dish
Cross over —] E
SkyStar USB network cable PC2
SERVER CLIENT
IP: 192.168.0.1/24 IP: 192.168.0.2/24

Figure 5.1: Multicast test configuration

The multicast server is equipped with a SkyStar USB card and correctly connected to
a dish. The satellite on which the dish is aligned to and the channel, which will be

streamed over the LAN, is unimportant for this example.

The connection between both systems will be realized with a cross-over network
cable for direct connection. It is also possible to use a 100/1000MBit/s network switch

or a 100/1000MBit/s Ethernet hub.
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On our server, we open "Settings" => "Options" and change to the "Recorder" tab.

O ptions
Preferences: i
The Options are changing the appearance and behawviour of the DWE Yiewer, [ﬁr‘j‘g
(S
i:_“] General IP-Settings:
[_1 Enhanced
= O Teletext &EPG Wetwork InkerFace:
Telstext 192,168.233, 235 |
EPG '
SiehFern Infa IP-Address: Fort:
Subtitles P [
4 ;??92

rder

1 Reco

= [ Inpuk
Kevhoard
WinLIRC
Mouse
(] Hardware
23 scheduler

[ ok ][ cancd |

Figure 5.2: Options menu “Network”

Here you have to configure the necessary options for the IP multicast stream.

First you have to choose the IP-address of the network interface, the multicast
stream is sent for distribution. In our example, the network interface has the IP
192.168.0.1

The second information, which is necessary for IP multicast, is the multicast address
and the port the stream is located on.

If the MC-IP is valid, MC-IP field is filled with green colour. If the IP is invalid, the field
is red.

The multicast IP range is specified in RFC 1112 (Aug-01-1989) and the following
RFC documents. Multicast IP addresses are defined to the range between 224.0.0.0
to 239.255.255.255. If you want to send the stream to all clients in your subnet, you
have to use the multicast IP 224.0.0.1. For further information about multicast IP
addresses you should read the RFC document.

The multicast port number, you have to choose, can be chosen from the range
between 0 and 65500. You should not use the first 1024 ports because they are
reserved/used by IP services.

In our example we use the multicast IP 224.0.0.1 for all clients in the local subnet and
the port number 7792.

Now press OK to confirm the settings and close the options window.

Now you can start the multicast IP streaming.
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B oYEvIEWER | CHANREL [HEW | SETTINGS F =[5 2

Blways On Top

Show Subtitles

DeskbopTy
Fullscresn
Pulkicast

Figure 5.3: Mam wmdow “View” menu with disabled multlcast optlon

To initialise the multicast stream, choose "View" => "Multicast". Now the current
channel will be sent to the selected network interface.

To receive and view the data stream, a streaming client is required. In our example
we use the application "VLC Media Player". This open source application is available
at the project website http://www.videolan.org/vic/.

Start the application.

£ YLC media player

File Wiew Settings Audio Wideo Mawigation Help
= p EH M4 o« M oM = < [Wwm
»x1.00

Figure 5.4: VLC media player

Here you simply click onto "File"...
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& VLC meadia player

FEW Wiew Settings  Audio  Wideo Mawigation Help

Guick Open Filz.., ko < [um )
Cpen File.., ChH-F
Open Directary... Ctrl-E
Open Disc. .. Chrl-D

Cipen Metwork Streangy. . Chel-h

Cpen Capture Dewice,t,  Chrl-A

‘Wizard. ., Chrl-4
Exit Chrl-e
x1.00

Figure 5.5: VLC media player “File” menu

... and then select the option "Open Network Stream...".

Media Fesowce Locator (MEL)

Open: |udp:e’f’@224.ﬂ.ﬂ.1:??92 v|

Altermnatively, you can build an MEL using one of the following predefined targets:

Fie | Disc | Motwork | DiectShow]

O UDF/RTF Pot [T8 ] Foree [Py
) UDF/RTF Multicast bodess (224001 | pam [z |2
O HTTRHTTRS FTR/MMS AL i
(I RTER IRL : T |

[CTdllave timeszhifting

[15team output Sellirigs.. [ Caching ! i

[ ok ] [ Cancel ]

Figure 5.6: VLC media player “Open...” menu

Then you have to choose "UDP/RTP Multicast" and enter the address and port
number where the multicast IP stream is located on.

Then press the "OK" button and VLC Media Player will start the playback of the
stream immediately.
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Figure 5.7: VLC media player during multicast stream playback

If you want to stop the streaming client playback, simply press the stop button.
If you want to stop the streaming server of DVBViewer TE, you have to uncheck the
"Multicast" option in "View" menu.

T CHANNEL TWSEM® T SETTINGS

Show Subtitles

DeskbopTy
Fullscresn
W Mulkicast

Figure 5.8: Mam wmdow “View” menu with enabled muItlcast optlon

53 Version 4.4.1



TechniSat DVB-PC TV Stars - Users Guide Part DVBViewer TE
Appendix A: TechniSat remote control and keyboard commands

Appendix A: TechniSat remote control and keyboard
commands

TechniSat TS35

Recorder window
Aspect ratio
Exit
Mute
Start / stop recording
Number field
Show / hide menu
EPG info
Channel up/down
Volume up/down
Pause / resume
EPG window
Full screen
100% size
200% size
50% size
DesktopTV
Teletext
Stop

Figure B.1: TechniSat remote control T35 (default configuration)
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TechniSat TTS35AlI

Mute Exit

Number field
Start / stop recording Recorderwindow
100% size 200% size
50% size Desktop TV
Channel up/down 1
Volume up/down 1
Pause / resume
Full screen
EPG window EPG info
Channel up/down 2 Volume up/down 2
Menu
Aspect ratio

Teletext Stop

TechniSat

Figure B.2: TechniSat remote control TS35AI (default configuration)
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Keyboard commands
Assigned short keys (default settings):

Pause / resume P Change TV/Video F9

Always On Top F1 Show Subtitle F10
Hide Menu F2 Plus 10 sec. -
Show Statusbar F3 Minus 10 sec. +
Show Toolbar F4
Fullscreen F NumberO0 O
Exit ESC Number1l 1
Number2 2
Channel list C Number3 3
Channel Minus DOWN ARROW Number4 4
Channel Plus UP ARROW Number5 5
Save Channel CTRL +S Number6 6
Station Minus PgDown Number 7 7
Station Plus PgDup Number 8 8
Number9 9
Aspect Ratio V
Zoom Z Favorite 1 SHIFT + 1
Options O Favorite 2 SHIFT + 2
Favorite 3 SHIFT + 3
Mute M Favorite 4 SHIFT +4
Volume Up RIGHT ARROW Favorite 5 SHIFT +5
Volume Down LEFT ARROW Favorite 6 SHIFT + 6
Favorite 7 SHIFT + 7
Display D Favorite 8 SHIFT + 8
50% size F5 Favorite 9 SHIFT +9
100% size F6 Favorite 0 SHIFT +0
200% size F7
Desktop TV F8 Record settings S
Record video/audio R
Teletext T
Mini EPG |
EPG Window E
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